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Introduction

Welcome to Dolphin EasyConverter. The software that converts documents into
alternative formats.

What is alternative format?
Here are some questions and answers that will help clarify what is meant by the term
alternative format:
Q1. What is alternative format?
Alternative format or simply alt format refers to the transcription of books or other content
(such as notes, newspapers or magazines) into a format other than standard print.
Equally, alt format might just mean converting from one type of file format to another; such
as Adobe PDF to a Microsoft Word document.
Q2. What are the main types of alt format?
The most common types of alt format are large print, Braille, tactile diagrams, audio and
DAISY digital talking books.
Q3. Who will alt format benefit?
People who are either visually or print impaired can have difficulty reading standard print
and relate more easily to some of the other formats such as large print, Braille, audio or
DAISY digital talking book.
Q4. What is DAISY?
DAISY (digital accessible information system) is an international standard that prescribes
how digital talking books (DTB) are prepared. A DTB will have a structure that will allow
the reader to easily navigate the text, for instance, heading by heading or page by page.
If it contains audio, this will typically be tied to the text. There are different types of DAISY.
A DAISY book can be text only or audio only or a combination of audio and text. The audio
can be recorded speech or computer generated speech. This is likely to vary depending
on whether it is a recreation book or a text book.
Q5. Where can I get additional information on alt format?
To learn more about alt format visit www.altformat.org.
To learn more about DAISY visit the DAISY Consortium at www.daisy.org.

Supported formats
Dolphin EasyConverter supports a number of different input formats and can produce from
them a number of different output formats.
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Supported input formats:












Plain text files (.txt).
Rich text files (.rtf).
Microsoft Word document files (.doc, .docx).
Portable document format files (.pdf).
NIMAS (National Instructional Materials Accessibility Standard) files.
DTBook DTD compliant XML files.
Open Electronic Publication (.epub)
Paper documents input via optical character recognition (OCR).
Image files (.JPG, .JPEG, .BMP, .TIF, .TIFF).
Kurzweil 3000 Documents (.KES).
Hypertext markup language (HTML) files (.html, .htm)
Dolphin EasyConverter does not support HTML files with a linked CSS file.

Supported output formats:







Text files (.txt).
Compressed audio files (.mp3).
Audio CD
DAISY 2.02 and DAISY 3.0 compliant digital talking book (DTB)
Large print (.doc).
Braille.
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Installation
Installing
To install Dolphin EasyConverter:
1. Insert the Dolphin EasyConverter CD into your CD drive.
The installation process should start automatically and you will see a Welcome
Screen.
2. Follow the on-screen instructions to complete the installation.
Should the installation process fail to automatically start:
1. Click the Window's "Start" button to open the Start menu.
2. Click "Run...".
If the Start menu does not contain the "Run..." option then press Windows Key +
R. This will open the Run dialog.
3. Click the "Browse" button.
4. Navigate to your CD-ROM drive and select the file "SetupEasyConverter.exe".
5. Click "OK" and the installation will start.
6. Follow the on-screen instructions to complete the installation.
If problems persist then please refer to the closing chapter to learn about available sources
of technical support.
During the installation of Dolphin EasyConverter, a software synthesizer and Dolphin
EasyReader will be installed.

Activating
After installing your licensed copy of Dolphin EasyConverter, it is then necessary to
activate the product. Product activation is required in order to obtain a software license.
Without a software license Dolphin EasyConverter will only run for 30 days.
WARNING - please ensure you review the End User License Agreement before
activating. Once Dolphin EasyConverter has been activated a refund is not available.
If product activation remains outstanding then you will be informed regularly that product
activation is required and of the number of days remaining before Dolphin EasyConverter
expires.
When you are presented with the product activation dialog you can choose "Activate now"
or "Remind me later".
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Activate now
Product activation can be done in 3 ways: Internet activation, manual activation or via the
entering of a multi user license code.


Internet activation.
Internet activation is the simplest procedure because activation is automatic. This
will require you to have an Internet connection. The procedure will connect to the
Dolphin server where EasyConverter will be automatically allocated an activation
code.



Manual activation.
The manual process will require you to enter an activation code that is based
upon your unique product key. Your product key value is shown during the
manual activation process.
To obtain an activation code you should contact your local Dolphin dealer and
report to them your product key. From this key they will be able to issue you with
an activation code.



Multi user license.
If you have purchased a multi user or network license then you can enter in your
unique multi user license code. This is printed on your multi user license
software certificate.

Remind me later
If you choose "Remind me later" you will then be informed regularly that activation is still
required and of the number of days remaining to perform this task.
To re-commence the activation process you should restart Dolphin EasyConverter or
select the "Activate" button found in the "Help" menu.
Uninstalling and re-installing EasyConverter onto the same computer does not result in an
additional license being required. If you require an additional license then please contact
your Dolphin dealer.
During the activation process Dolphin does not obtain any personal information from your computer
besides your product license key.

Uninstalling
To uninstall Dolphin EasyConverter open the Windows Control Panel, choose
"Add/Remove Programs", and then choose the "Dolphin EasyConverter" entry in the list of
programs.
Uninstalling Dolphin EasyConverter will not remove any existing projects that have been
saved. Projects can be removed by using Windows Explorer to navigate to the target
folder and then by manually deleting the folder.
The software synthesizer and Dolphin EasyReader that are automatically installed with
Dolphin EasyConverter must be separately uninstalled. Entries can be found in the
Add/Remove Programs applet in the Windows Control Panel.
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Setting up an embosser
If you are using Dolphin EasyConverter to produce Braille then it is important to ensure
your embosser is installed correctly in Microsoft Windows. We recommend you refer to
your embosser's support documentation for instruction.
If the steps to set up your embosser remain unclear then the following steps should be
taken to install and configure your embosser.

Setting up an embosser:

1. Locate and run the "Add Printer" wizard. This can be accessed through the
Windows Control Panel.
The Microsoft Windows "Add Printer" wizard is a program which will ask you
questions about what sort of printer you have and where it is connected.
2. When the wizard asks you for the port name where the printer is connected,
choose the port that your embosser is connected to from the list.
3. When the wizard asks you for the manufacturer and model of your printer choose
"Generic" and "Generic / Text Only".
4. To confirm that the communication settings are correct (especially important if
your embosser is connected to a serial port) choose the “Configure Port”
command button.
It is recommended that you give your embosser a meaningful name. The name you give
here will be the name used to identify your embosser in Dolphin EasyConverter.
Note: If you decide to reconfigure your embosser: from the Windows Control Panel choose
"Printers", highlight the name of your embosser and from the "File" menu choose
"Properties".
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How to find help

You can access the EasyConverter help in several ways.
You can:




Press F1 at any time. Press this at any time for a relevant help topic. For example
if you are at the 'Document settings' stage of the conversion wizard and you press
F1 then the help file will open at the relevant section.
Select the 'Help' button from the opening page.
Go to the 'Help' menu on the opening page.

You can continue to use EasyConverter with the help window open.
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Quick start tutorial
This chapter contains a number of step-by-step tutorials to help get you up and running
quickly with Dolphin EasyConverter. You will have a chance to perform some of the
different conversions that are possible and become familiar with the user interface and
conversion process.
You will find some sample documentation in the Dolphin EasyConverter installation folder
(C:\ Program Files \ Dolphin \ EasyConverter501 \ Samples). These documents have been
included to help you work through the tutorials.
The tutorials will guide you through the conversion process using Dolphin EasyConverter's
default settings.
In practice, you will want to adjust the available settings to meet your requirements.

Overview
Dolphin EasyConverter provides the tools to convert a standard document into an
alternative format. There are three main stages to this process.


Input stage.

Your input document can be an existing file in a supported format, or any other hard copy
document. You can use Dolphin EasyConverter's OCR editor to scan printed material such
as letters, books or exam papers.


Intermediate stage.

You can edit your input document within EasyConverter before you make your final
conversion into an alternative format. You can use this to make any changes to content,
spelling or formatting such as heading styles. This is all done within Microsoft Word. You
can choose to skip this step if you wish.


Output stage.

You can choose which format you want your input document to be converted into. You can
then decide between a number of media options that are related to the format itself for
example to send your large print format to your local printer or burn your MP3 to a CD.
You can choose to run the entire process at once or just perform a partial conversion. A
partial conversion means that no output format is selected, with the source document only
being converted to the intermediate stage. Both a full and partial conversion can be saved
as a Dolphin EasyConverter Project.
Saving the conversion as a Dolphin EasyConverter Project means the conversion of the
source document does not have to be repeated. This makes it quicker to produce
alternative formats for the source document in the future.

Converting a file
Two tutorials are provided on how to convert a source file into an alternative format.
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Use the Quick Conversion to create an MP3
In this tutorial you will learn how to convert a rich text file into an MP3 and save it to your
"Documents" folder using the "Quick Conversion" tool.
You can use the "Quick Conversion" tool to make a conversion with the minimum of steps.
To use the Quick Conversion to create an MP3
1. Start your conversion from here: Select "Quick Conversion" from the main
EasyConverter window. This will take you straight to the "Choose your input"
screen.
2. Choose your input document: Select the "Open a file" radio button and then
"Browse".
3. Choose your input document: Locate the file "Tut1.rtf" using the Open dialog (C:\
Program Files \ Dolphin \ EasyConverter501 \ Samples). Choose "Next" to move
on.
4. Choose your alternative format and destination: Select "MP3" from the "New
output type" drop down list box. Enter a name for your MP3.
5. Choose your alternative format and destination: The project is saved to a default
location that is shown in the "Output folder" field. To change this select "Browse"
6. Choose your alternative format and destination: Your project will be saved to your
default location. If you wish to save an additional copy to another location,
CD/DVD or USB device select the appropriate option from the "Copy it to" drop
down list box. You can also select "No copy to" which will not save an additional
copy.
7. Choose your alternative format and destination: Select "Finish" to begin the
conversion.
8. Conversion in process: When the conversion is complete select "Done" to return
to the Dolphin EasyConverter main screen.
9. Open the file by selecting "View Output" or by opening the file from its saved
location.
Convert a text file into DTB using intermediate editing
In this tutorial you will learn how to create a Digital Talking Book (DTB), with built in
speech, from a text file. You will use the "New Project" option and edit the intermediate
document before converting to the chosen output.
Intermediate editing allows you to make changes to your document before the final
conversion process. You will edit the document using Microsoft Word.
To convert a text file into DTB using intermediate editing:
1. Start your conversion from here: Select "New Project". This will take you to the
"Project Information" screen.
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2. Project Information: Enter a name for your project. You can change where the
project is saved to by using the "Browse" button. Choose "Next" when you have
finished.
3. Choose your input document: Select the "Open a file" radio button and then
"Browse".
4. Choose your input document: Locate the file "Tut2.txt" using the Open dialog (C:\
Program Files \ Dolphin \ EasyConverter501 \ Samples). Choose "Next" to move
on.
5. Document settings: Select "No" under "Use heading detection during conversion"
as you are going to do this manually later in the tutorial. If, in the future, you want
EasyConverter to do this for you then select "Yes".
6. Document settings: Select "Yes" under "Edit the intermediate document in
Microsoft Word during conversion". Choose "Next" to move on.
7. Choose your alternative format: Select "DTB" from the "New output type" drop
down list box. Choose "Daisy 2.02" from "DTB Type".
8. Choose your alternative format: Select the "Yes" radio button, this will make a
DTB with a built in voice. Choose your voice and lexicon from the drop down list
boxes and then "Next" to continue.
9. Choose your output name for DTB: Enter a name for your output. You also have
an option to add extra information to the output name. Choose between the
format type (DTB), the date of creation, name of the built in voice and name of the
lexicon. If you do not wish to add this information de-select the "Append selected
item to the output name" check box.
10. Send your alternative format: Your project will be saved to your default location. If
you wish to save an additional copy to another location, CD/DVD or USB device
select the appropriate option from the "Copy it to" drop down list box. You can
also select "No copy to" which will not save an additional copy.
11. Start the conversion: Select "Finish" to begin the conversion.
12. Intermediate document editor: When the intermediate editor opens make the
following changes to the text file:
 Locate the text "Introduction" and assign a heading 1 style to this paragraph.
 Locate the text "What is alternative format?" and apply a heading 2 style to this
paragraph.
 Locate the text "Supported formats" and apply a heading 2 style to this
paragraph.
13. Intermediate document editor: Select "Save and return" to continue the
conversion.
14. Conversion in process: Select "Done" to complete and return to the
EasyConverter main screen.
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15. View the DTB by selecting "View Output" or by opening the file from its saved
location.

Converting from scanned text
In these tutorials you will learn how to import source documents into an intermediate
format using Dolphin EasyConverter's OmniPage OCR engine and convert PDFs. You will
also learn how to open an intermediate document and from this create an alternative
format conversion.
Import a hard copy document into an intermediate format (requires a scanner)
In this tutorial you will learn how to import a hard copy document from a scanner to the
intermediate format.
To do this:
1. Start your conversion from here: Select "New Project". This will take you to the
"Project Information" screen.
2. Project information: Enter a name for your project. You can change where the
project is saved to by using the "Browse" button. Choose "Next" when you have
finished.
3. Choose your input document: Select the "Scan one or more papers" radio button
and then choose "Next" to continue.
4. Choose your scanned input document settings: Select your scanner from the
"Scanner Device" list and the document language from the "Document Language"
list.
5. Choose your scanned input document settings: Select "No" under "Use OCR
Editor for pre processing" (select yes to edit the document in the OCR Editor) and
then choose "Next" to continue.
6. Document settings: Select "No" under "Use heading detection during conversion".
Select "No" under "Edit the intermediate document in Microsoft Word during
conversion". You can choose "Yes" should you wish to edit the document in
Microsoft Word. Select "Next" to continue.
7. Choose your alternative format: Select "No alternative format" from the "New
output type" list. This will import the document without creating an alternative
format output. Select "Next" to continue.
8. Start the conversion: Select "Finish" to begin the scan. The "Continue automatic
processing" window will appear when the scan has completed. Select "Stop
loading pages" to move on or "Add more pages" to scan more pages. These
pages will be added to the project.
9. Your document has now been imported and can be used for the "Convert an
intermediate document" tutorial.
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Convert an intermediate document
In this tutorial you will learn how to convert a file that is in intermediate format. You will
also be introduced to the "Properties" window in the "Intermediate Editor". The file created
in the "Import a hard copy document into an intermediate format" tutorial is perfect for this.
1. Start your conversion from here: Select "Open Project" and choose the file
created in the previous tutorial.
2. Project view: Select "Edit Document". This will open the document in Microsoft
Word for you to edit.
3. Intermediate document editor: Select "Properties". This will open the "Summary
Info" window that allows you to add details and comments about the document.
4. Summary Info: Select "Statistics" to see statistics about the document. Select
"Close" and then "Okay" to save any changes you have made or "Cancel" to exit.
5. Intermediate document editor: Select "Save and return" to save any changes and
return you to Dolphin EasyConverter.
6. Project view: Select "Alternative Formats". This will take you to the "Choose your
alternative format" stage of the wizard.
7. Choose your alternative format and destination: Select "MP3" from the "New
output type" drop down list box. Enter a name for your MP3.
8. Choose your alternative format and destination: The project is saved to a default
location that is shown in the "Output folder" field. To change this select "Browse"
9. Choose your alternative format and destination: Your project will be saved to your
default location. If you wish to save an additional copy to another location,
CD/DVD or USB device select the appropriate option from the "Copy it to" drop
down list box. You can also select "No copy to" which will not save an additional
copy.
10. Choose your alternative format and destination: Select "Finish" to begin the
conversion.
11. Conversion in process: When the conversion is complete select "Done" to return
to the Dolphin EasyConverter main screen.
12. Open the file by selecting "View Output" or by opening the file from its saved
location.
A PDF file to large print with auto edit disabled
In this tutorial you will learn how to create a large print document out of a PDF. We shall
use the "New Project" option.
Converting a PDF uses the OCR, which is the same process as a scanned image.
To do this:
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1. Start your conversion from here: Select "New Project". This will take you to the
"Project Information" screen.
2. Project information: Enter a name for your project. You can change where the
project is saved to by using the "Browse" button. Choose "Next" when you have
finished.
3. Choose your input document: Select the "Open a file" radio button and then
"Browse".
4. Choose your input document: Locate the file "Tut3.pdf" using the Open dialog (C:\
Program Files \ Dolphin \ EasyConverter501 \ Samples). Choose "Next" to move
on.
5. Import whole or parts of the book: Choose which parts of the book you want to
process. You can select the whole document, specific pages (e.g. 1, 2, 5) or page
ranges (e.g. 1-5, 12-15). Choose "Import all pages". Choose "Next" to move on.
6. Choose your PDF and image document settings: Select "No" under "Use OCR
editor for pre processing" (choose "Yes" to edit the document with the OCR
Editor) choose "Next" to move on.
7. Document settings: Select "No" under "Use heading detection during conversion"
or select "Yes" to have EasyConverter detect any headings that are in the
document.
8. Document settings: Select "No" under "Edit the intermediate document in
Microsoft Word during conversion". Select "Yes" to edit the document in Microsoft
Word. Choose "Next" to move on.
9. Choose your alternative format: Select "Large Print" from the "New output type"
drop down list box. From here you can also choose the formatting options for the
output. Choose "Next".
10. Choose your output name for Large Print: Enter a name for your output. You also
have an option to add extra information to the output name. Choose between the
format type (Large Print), the date of creation and size of font. If you do not wish
to add this information de-select the "Append selected item to the output name"
check box.
11. Send your alternative format: Your project will be saved to your default location. If
you wish to save an additional copy to another location or print the document
select the appropriate option from the "Copy it to" drop down list box. You can
also select "No copy to" which will not save an additional copy.
12. Start the conversion: Select "Finish" to begin the conversion.
13. Conversion in process: Select "Done" to complete the conversion and return to
the Dolphin EasyConverter main screen.
14. Open the file by selecting "View Output" or by opening the file from its saved
location.
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OCR Editor
In this tutorial you will learn the basic functions of the OCR editor. You will import two
pages of a hard copy document, use the OCR editor to recognize the text and make some
basic changes. For this tutorial you will need two pages of a hard copy document and a
scanner.
Import hard copy document
1. Start your conversion from here: Select "New Project". This will take you to the
"Project Information" screen.
2. Project information: Enter a name for your project. You can change where the
project is saved to by using the "Browse" button. Choose "Next" when you have
finished.
3. Choose your input document: Select the "Scan one or more papers" radio button
and then choose "Next" to continue.
4. Choose your scanned input document settings: Select your scanner from the
"Scanner Device" list and the document language from the "Document Language"
list. Select "Yes" under "Use OCR Editor for pre processing" and then choose
"Next" to continue.
5. Document settings: Select "No" under both "Use heading detection during
conversion" and "Edit the intermediate document in Microsoft Word during
conversion" and then choose "Next" to continue.
6. Choose your alternative format: Select "Text" as the alternative format from the
"New output type" list and then choose "Next" to continue.
7. Choose your output name for text: Enter a name for your output and choose
"Next" to continue.
8. Send your alternative format: Choose "No copy to" from the drop down list box.
9. Start the conversion: Select "Finish" to begin the scan.
10. Continue automatic processing: When this window appears place the second
page of the hard copy document onto the scanner and select "Add more pages".
This will import the second page.
11. Continue automatic processing: When this window re-appears select "Stop
loading pages".
12. Dolphin EasyConverter OCR Editor: If there is a section of the document that you
want Dolphin EasyConverter to ignore then use the Ignore Tool to draw a box
around it.
13. Dolphin EasyConverter OCR Editor: Select "Start OCR". Dolphin EasyConverter
will now recognize the text and make it available for you to edit using the OCR
editor.
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14. Dolphin EasyConverter OCR Editor: You can now edit the document using the
available tools. Select "Save & Return" to exit the OCR editor and begin the
conversion.

Adding EasyReader Express to a conversion
In this tutorial you will learn how to add EasyReader Express to your Digital Talking Book
(DTB). EasyReader Express is a subscription service and requires an Internet connection.
Visit the Dolphin web site to learn more about this service.
To convert a text file into DTB with audio and add EasyReader Express:
1. Start your conversion from here: Select "New Project". This will take you to the
"Project Information" screen.
2. Project Information: Enter a name for your project. You can change where the
project is saved to by using the "Browse" button. Choose "Next" when you have
finished.
3. Choose your input document: Locate the file you wish to convert and choose
"Next" to continue.
4. Document settings: Select "Yes" under both "Use heading detection during
conversion" and "Edit the intermediate document in Microsoft Word during
conversion". Choose "Next" to move on.
5. Choose your alternative format: Select "DTB" from the "New output type" drop
down list box.
6. Choose your alternative format: Choose "Yes" to "Generate DTB audio with
speech synthesizer" and check the check box "Yes, add EasyReader Express to
the DTB". Note that you must add audio to your DTB if you want to include
EasyReader Express. Choose "Next" to continue.
7. EasyReader Express: Enter your username and password and choose "Add
Express" to continue.
8. Choose your output name for DTB: Enter a name for your output. Choose "Next"
to continue.
9. Send your alternative format: Your project will be saved to your default location. If
you wish to save an additional copy to another location, CD/DVD or USB device
select the appropriate option from the "Copy it to" drop down list box. You can
also select "No copy to" which will not save an additional copy.
10. Start the conversion: Select "Finish" to begin the conversion.
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EasyConverter interface
You will start all of your EasyConverter projects from the main screen so it pays to become
familiar with it. The screen is split into three sections to help distinguish between the
different tools and stages of projects.
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Start your conversion from here

The first section labelled "Start your conversion from here" is where it all begins.
This section contains:




New Project: Starts the project wizard that will guide you through your project and
conversion.
Quick Conversion: Starts a shortened version of the wizard that misses out the
"Project Information" and "Document Settings" steps.
Open Project: Opens a project that is in either a complete or an intermediate
stage. The project can then be viewed or worked on.

Project view

The second section labelled "Project View" allows you to make changes to a project as
well as see details about the various files involved.
The section contains:






Title: Shows the name of the input document.
Input: Shows the file path to the input document.
Project: Shows the file path to the completed output file.
Edit document: Allows you to continue working on your intermediate document.
When you press this button your document will be sent to Microsoft Word for
editing.
Alternative formats: This button will convert your intermediate document into an
output format of your choice.
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Resulting alternative formats

The third section titled "Resulting alternative formats" allows you to work with alternative
format outputs that you have made from your project.
This section contains:






Text Box: The text box shows what formats the current project has been
converted into, when that format was created and how large the file is.
Copy to: Outputs your conversion to relevant media, for example print your large
print document, emboss your Braille file or burn your Digital Talking Book (DTB)
to CD.
View Output: Allows you to view your conversion through a compatible application
for example open your DTB in Dolphin EasyReader or your MP3 in Windows
Media Player.
Location: Takes you to the file location of your project.
Delete output: Remove the selected conversion from the list.

Windows Explorer context menu

Page 22

If the current file format is supported by Dolphin EasyConverter then the Windows Explorer
context menu will provide easy access to the conversion process.
In Windows Explorer, to access the context menu either press the Application Key, press
Shift+F10 or right click on the selected file.
The item in the context menu will either be "Convert document with Dolphin
EasyConverter" or "Open project with Dolphin EasyConverter". Selecting this item will
launch Dolphin EasyConverter with the input file selected or the project opened at its
previously saved state.
If you have checked the option "Automatically start conversion on drag/drop" in the
"General" settings then conversion will start automatically with Dolphin EasyConverter's
last used settings.
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OCR conversion
Dolphin EasyConverter includes an optical character recognition (OCR) engine that can
process both data from a scanner and data from image based PDF documents.
The converting of PDF documents will seamlessly move from the input to the intermediate
stage. The processing of data from a scanner adds an additional step before the creation
of the intermediate document.
This additional step provides you with the opportunity to review and edit the scanned
image, allowing you to scan additional pages, correct recognition errors, adjust layout
inaccuracies and assign alternate text descriptions for graphics. Only after this step is the
scanned data processed by the data analyzer and then the intermediate document is
created.

OCR editor overview
The OCR editor has 3 main sections:




Pages.
Adjust page layout.
Preview OCR Result.

Pages

This section shows all pages of the imported document. Selecting a page from here will
make it available to view and edit within the "Layout" section. When the text has been
recognized the page will also be visible and available for editing in the "Edit" section.
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Adjust page layout

This section shows the structural layout of the page. From here, you can make changes to
the layout and content of the document. For example, choose to omit certain sections of
text.
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Preview OCR Result

This section shows a preview of the final document after it has been recognized. You can
use this section to make any changes to the document for example formatting, correcting
spelling, highlighting and striking through text. You can also mark text for redaction and
alter the reading order.

OCR Editor Toolbar
The OCR Editor Toolbar contains a number of tools and options.
Add

This allows you to import additional compatible documents, such as PDFs, into the current
project. You can edit these with the OCR editor.
Scan

With this option you can import additional hard copy documents into the current project
from a scanner.
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Settings

Here you can change the settings for your scanner.
Pages

You can use this box to quickly go to a page number. You can either type in the page
number or choose a page number from the list.
Set Page

Sometimes the pages you are processing might not begin on page 1. For example, you
might be processing a particular chapter in a text book that begins on page 20. To keep
the page numbers true to the original page numbers, use the "Set Page" option.
The "Set Page" option allows you to edit the page number for the current page and will
automatically renumber any subsequent pages. You can also make a specific page
unnumbered by either typing in the number 0 or leaving the page number blank.
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Scanning Method

Choose how EasyConverter should interpret the document during the OCR process by
selecting a scanning method. If you select "Auto" then EasyConverter will attempt to
choose the best scanning method for the OCR process. You should select "Simple" if your
document has a simple layout and very few graphics. Select "Standard" for more complex
document layouts and select "Fast" if you require a quick processing time, your document
has no graphics and has a simple one column layout.
Recognition Language

The OCR language should match the language of the document being scanned. This will
improve accuracy when text is analyzed during the OCR process.
Pages to recognize

Select which pages you would like EasyConverter to recognize.
Start OCR

Any file that is seen as an image, such as a scanned hard copy or a PDF, must go through
a recognition process. By selecting "Start OCR", Dolphin EasyConverter will recognize the
letters within the image and turn it into a text file which you view in the "Edit" section.
Proof Wizard

Acts as a basic spell checker and will alert you to any text that cannot be distinguished.
Save document

A document can be saved in these different ways. Select the appropriate one from the list:
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Plain Text




All formatting information, such as fonts and alignment, is ignored and replaced
by defaults. (One column, left aligned paragraphs, a default font etc.)
Tables and images are retained and placed within the text.
Highlights, strikeouts and making for redaction (editing options available in the
"Edit" section") are not transferred to the converted document but redacted text is
blacked out.

Formatted Text




The formatting information for fonts and paragraphs is retained but the layout
information is ignored.
Highlights, strikeouts and redactions are conserved.
Has a special purpose when saving to Excel: each detected table or spreadsheet
in a document is saved to a separate worksheet. Other content is placed on the
last worksheet and functions as an index. The tables are replaced by hyperlinks to
their own sheet.

Save and return

Exit the OCR Editor and return to the EasyConverter wizard.

OCR editor hotkeys and keyboard shortcuts
The OCR editor contains a number of hotkeys and keyboard shortcuts that can make
editing easier and faster.
OCR editor main dialogue
The main dialogue in the OCR editor has the following shortcut keys:
Function
Add more pages from file
Add more pages from scanner
Settings
OCR pages
OCR current page only
Proof wizard
Save and return to EasyConverter

Key Press
CONTROL + O
CONTROL + S
CONTROL + P
F5
CONTROL + F5
F7
CONTROL + W

Thumbnail View Control
The Thumbnail View Control (TVC) in pane 1 has the following keyboard shortcuts:
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Function
Scrolls screen up and selects top
page
Scrolls screen down and selects
bottom page
Selects first page

Selects last page

Selects previous page
Selects next page
Activates page (i.e. displays page
in Image View Control)
Change focus without selecting
page
Select / de-select focused page
Delete selected pages from the
document
Cut selected page

Copy selected page to the
clipboard

Paste pages from the clipboard

Key Press
PAGE UP
PAGE DOWN
HOME
or
LEFT ARROW
END
or
RIGHT ARROW
UP ARROW
DOWN ARROW
ENTER
CONTROL +
ARROW KEYS
SHIFT +
SPACEBAR
DELETE
CONTROL + X
or
SHIFT + DELETE
CONTROL + C
or
CONTROL +
INSERT
CONTROL + V
or
SHIFT + INSERT

Image View Control
The Image View Control (IVC) in pane 2 contains the following keyboard shortcuts:
Function
Remove a zone from the zone
collection

Key Press
DELETE

Text editor control
The Text Editor Control (TEC) contains the following keyboard shortcuts:
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Function
Bold font
Italic font
Underlined text
Proof wizard
Show verifier
Show verifier (always)

Key Press
CONTROL + B
CONTROL + I
CONTROL + U
F7
F8
F9
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Braille conversion
Dolphin EasyConverter includes a Braille converter that transcribes the intermediate
document into high quality Braille. The Braille converter is designed to give automatic
Braille transcription, preserving document formatting, without the need for time-consuming
document preparation by entering special format codes.
Dolphin EasyConverter's Braille converter takes its cue from the Word document itself.
For example, if you center text in the document then it is centered in the Braille, if you use
a bulleted list then it will come out as a list in the Braille, and all without any intervention
by you.
The Braille conversion can be sent directly to the embosser or it can be previewed and
edited in Dolphin EasyConverter's Braille editor. The editor can show your Braille
document either as Braille dots or as ASCII characters and is especially useful for
checking and adjusting the layout of the document.
For more information on setting up an embosser please see "Setting Up An Embosser" in
the "Installation" chapter.

Braille editor overview
You can open the Braille editor and make changes to your Braille by selecting "View In"
from the "Resulting alternative formats" section of the main page. The editor lets you move
around the Braille document to review it prior to embossing.
The Braille editor displays your text either as Braille dots or as ASCII characters. You can
switch between showing the document as Braille dots or ASCII characters by using the
"ASCII", "Braille" or "Braille Shadow" commands in the "View" menu. The Braille editor will
also show the page break position for the embossed document.
Note: If you use a Braille display in conjunction with the Braille editor, make sure you set
its Braille table to the USA computer code. The Braille shown on the Braille display will
then show your document exactly as it will be embossed.
The Braille editor also includes the following features:







A status bar showing the current Braille page, line and column position and input
mode.
A back translation bar showing the reverse translation of the current line.
A customizable onscreen display font size.
A "Go to page" function.
A number of familiar editing functions, including undo, copy/paste and text
highlighting.
Text input using qwerty (text) or six-dot (Braille) entry.
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Editing the Braille output
The Braille editor provides "standard" text editing functions. This lets you edit your Braille
document in a similar way to how you would use an ordinary word processor. You can
insert and delete text and rearrange your text to suit your needs. Features such as text
highlighting, undo, cut, copy and paste are all available.
Text input mode
The Braille editor allows you to input Braille either by using characters (text input) or using
six keys like a Braille writer (six dot). You can select which to use with the Six Dot Input
command on the Edit menu. The status bar shows which input mode is currently in use.
When you enter text in the Braille editor, be aware that you are entering Braille characters.
The Braille editor does not translate text into Braille as you type, it assumes this has
already been done. For a list of which characters to use for the 63 possible Braille dot
combinations, please refer to the Character chart referenced later in this chapter.
When using the six dot input mode, use the F, D, S, J, K and L keys as the six Braille dots.
You can press these keys in combination to form the Braille characters. For example, the
letter A is input by pressing the F key; Braille letter B is input by pressing the F and D keys
together.
Note: the six dot input mode may not work on all PC keyboards. This is due to limitations
in some (mainly older) keyboards.
Back translation bar
At the top of the document window you will find a "Back translation bar". You can view or
hide this bar by using the "Back translation bar" command in the "View" menu.
The Back translation bar shows a rough reverse translation of the cursor line from Braille
back into text. This translation is purely for information, it is not necessarily an accurate
representation of your original document. It is provided to help non-Braillists identify
where they are in their document.
The "Back translation bar" uses only the primary back translation table, so, for example,
any text translated by other tables will not be shown correctly in the "Back translation bar".
Useful hot keys in the Braille editor
The Braille editor will look and feel like any standard editor. The navigation keys in the
editor, access to the menu bar and menu items can all be done in the usual way.
The table below provides a summary list of the editor's hot keys.
Function
Save
Emboss
Undo
Cut
Copy
Paste

Key Press
Ctrl + S
Ctrl + P
Ctrl + Z
Ctrl + X
Ctrl + C
Ctrl + V
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Select All
Clear
Go to page

Ctrl + A
Del
Ctrl + G

Character chart
The table below shows the Braille dots represented by each ASCII character. You may
find this table helpful if you need to insert Braille in the Braille editor.
Char
Space

Braille

Char
@

!

A

"

B

#

C

$

D

%

E

&

F

'

G

(

H

)

I

*

J

+

K

,

L

-

M

.

N

Braille
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Q
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R

3

S

4

T

5

U

6

V

7

W

8

X

9

Y

:

Z

;

[

<

\

=

]

>

^

?

_
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Embossing a document
You can emboss your Braille document by selecting "Embosser" in the "Send your
alternative format" stage. You can also use the "Send to" option in the "Resulting
alternative formats" section of the main page.
You can also emboss using the "Emboss" command on the "File" menu in the Braille
editor. The "Emboss" dialog will then appear prompting you for the number of copies and
which pages you want to emboss. Enter your settings into the dialog and press "Start" to
begin embossing.
Make sure your Braille embosser is loaded with paper, correctly connected to the
computer and ready to receive (switched on and online) before you press the button to
start embossing.
Embossing will then commence. Your document is sent to the Windows print spooling
system, so you can check the progress of your document in the Printers Control Panel.
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Settings
This chapter reviews the options in the Settings dialog. The dialog is opened by selecting
the "Settings" button on the main screen.

In the "Settings" dialog the controls are grouped into categories. The categories are
shown in a tree view in the left side pane.
When a category is selected the related options are shown in the right side pane.
Click or cursor left and right to open and close the different branches in the tree view.
Pressing TAB will navigate you through the options available in the right side pane.

Input
Input settings control scanning options including OCR settings and the scanner's hardware
device settings. Input settings also control how PDF files are processed.
There are also some general input settings. These apply to all conversions irrespective of
the input selected.
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Automatically detect headings in the document.
If selected, the input document will be processed to find headings to make the
output more navigable (that are not correctly marked up in the document as
headings).
Max words inside a heading.
This will set the maximum number of words that are considered to be in a
heading. This is used if the text portion that appears to be a non-marked up
heading contains more than the given words, then it is not considered as a
heading.
Max Image DPI.
EasyConverter can alter the resolution of images included within your document.
By default, this is set to 96DPI. This can only be used for NIMAS, DTBook, and
EPUB documents.
Allow EasyConverter to modify images to paper width.
Select this checkbox to allow EasyConverter to resize any images that are too big
for the output paper. This can only be used for NIMAS, DTBook, and EPUB
documents.

Scan OCR
The options available in this category control how the image from the scanner is
processed by the optical character recognition (OCR) engine.







Document language.
The document language should match the language of the document to be
scanned. This will improve accuracy when text is analyzed during the OCR
process.
Use OCR editor.
The OCR editor will let you adjust the scanned data prior to it being converted to
the intermediate document format. Unselect this option if you do not want to use
the OCR editor. Unselecting this option can produce improved results if the
scanned pages contain tables.
Save document as.
This option controls whether text formatting is saved during the OCR process. If
you do not want to retain text formatting then choose "Plain text" from the list.
Select your scanning method.
Choose how EasyConverter should interpret the document during the OCR
process by selecting a scanning method. If you select "Auto" then EasyConverter
will attempt to choose the best scanning method for the OCR process. You should
select "Simple" if your document has a simple layout and very few graphics.
Select "Standard" for more complex document layouts and select "Fast" if you
require a quick processing time, your document has no graphics and has a
simple one column layout.

Scanner Devices
The options available in this category control the scanner device and how the hardware
functions.
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Selected scanner.
This option states the scanner you wish to use; only scanners installed on your
operating system will be displayed. To choose a scanner, select it from the list.
Resolution.
This option sets the resolution of the scanned image. This should be set to
300dpi.
Color mode.
This option sets the color mode to use. The color mode refers to the type of image
you are scanning e.g. black and white, greyscale, color etc.
Paper source.
Selects what type of scanner is being used.
Enable Duplex scanning
Select this option if your scanner has duplex capability and you want to scan both
sides of your page.

Kes
The options available in this category control how the Kes project is processed. KES is the
project file for Kurzweil 3000, which contains all scanned pages.




Skip small images from KES files.
Kurzweil sometimes saves each scanned image as a small “thumbnail” image.
These are not suitable for the conversion process. You can automatically skip
these images by selecting this check box.
Skip black and white images when color is available.
Kurzweil sometimes saves both a color image and a duplicate black and white
image in a project file. You can choose to only use color images when available
by selecting this check box.

Output
DTB General
The options available in this category set the default general digital talking book (DTB)
settings.





Detection level.
The detection level determines whether the converted material should be
synchronized on sentence level or paragraph level.
DTB type.
It is possible to create different types of digital talking books. You can choose
between text only or text and audio. The created DTB is DAISY 2.02 or Daisy 3
(ANSI/NISO Z39.86-2005) compliant.
Page numbers.
The "Page numbers" list determines whether page numbers are to be part of the
output format. You can choose "No page numbers", "Original page numbers" or
"Word page numbers". The "Original page numbers" option retains the source
page references. The "Word page numbers" option takes the page numbers from
the intermediate Word document that is part of the conversion process.
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Generate audio with speech synthesizer
 MP3 audio quality.
Here you can select the MP3 output quality. There are 3 available levels: low,
normal and high quality.
 Add EasyReader Express to DTB.
If you select this option then you will be by default adding EasyReader
Express to your DTB conversions. EasyReader Express is a subscription
service and requires an Internet connection. Visit the Dolphin web site to learn
more about this service.



Style sheet.
When producing a DTB you can apply a cascading style sheet (CSS). The CSS
defines how certain elements should be displayed, for example, how the <h1> tag
should display text. To select your own style sheet, check this item and then
select your CSS file.

You can read more about CSS at http://www.w3.org/Style/CSS/.
DTB TTS
Dolphin EasyConverter can use any SAPI 5 compatible speech synthesizer to generate
audio output. In this category you can control the synthesizer’s speech output settings.








Voice.
The Voice option lets you choose the TTS voice to be used for audio output. You
can select from any of the SAPI5 synthesizer’s installed and supported on your
operating system.
Test text.
Enter some text and hear the selected voice speak it by pressing the "Test"
button.
Speed.
The speed setting sets the speed of the voice.
Pitch.
The pitch setting sets the pitch of the voice.
Volume.
The volume setting sets the volume of the voice.
Lexicon.
A lexicon lets you determine how certain character combinations are announced,
for example, Dr can be announced as doctor. A lexicon can also correct errors in
the way the TTS announces words. Dolphin EasyConverter provides the tools to
create and manage these pronunciation lexicons.

Dolphin EasyConverter also includes a TTS exclusion list. This external file contains
information on known problem TTS engines and will result in them being discarded by
Dolphin EasyConverter. At present the exclusion list contains the locked version of the
Travois TTS engine. The exclusion list should only be edited by an administrator with the
assistance of a Dolphin dealer or a member of Dolphin's Product Support staff.
Pronunciation lexicon
The DTB TTS settings and the MP3 TTS settings both share access to Dolphin
EasyConverter's pronunciation lexicon.
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From the settings you can select an existing lexicon, create a new lexicon, edit an existing
lexicon, or remove a lexicon.
When selecting the "New" button, the first task is to give the new pronunciation lexicon a
name.
This may correspond to the name of the TTS, the type of material being recorded or
perhaps the client's name. We do recommend that this name is clear and descriptive.
When working with the pronunciation lexicon you will be able to add, modify and remove
words from the lexicon. It is also possible to stipulate whether the characters are case
sensitive and whether they relate to a whole word or just part of a word.
Data stored in other lexicons can also be imported into the current lexicon via the "Import"
button.
Newly created lexicon files are saved as XML files, located in the following location:
On Windows XP:
"C:\Documents and Settings\All Users\Application Data\Dolphin\PronLexicons"
On Windows Vista
"C:\ProgramData\dolphin\PronLexicons"
MP3 General
The options available in this category set the default general MP3 settings.




MP3 track splitting.
Track splitting is used to determine if Dolphin EasyConverter should create one
MP3 file for the whole document or one MP3 file for each heading. An M3U
(playlist) file is also created in the conversion process.
MP3 audio quality.
This sets the MP3 output quality. There are 3 levels to choose from: low, normal
and high.

MP3 TTS
Dolphin EasyConverter can use any SAPI 5 compatible speech synthesizer to generate
audio output. In this category you can control the synthesizer’s speech output settings.







Voice.
The Voice option lets you choose the TTS voice to be used for audio output. You
can select from any of the SAPI5 synthesizer’s installed and supported on your
operating system.
Test text.
Enter some text and hear the selected voice speak it by pressing the "Test"
button.
Speed.
The speed setting sets the speed of the voice.
Pitch.
The pitch setting sets the pitch of the voice.
Volume.
The volume setting sets the volume of the voice.
Page 41



Lexicon.
A lexicon lets you determine how certain character combinations are announced,
for example, Dr can be announced as doctor. A lexicon can also correct errors in
the way the TTS announces words. Dolphin EasyConverter provides the tools to
create and manage these pronunciation lexicons.

Dolphin EasyConverter also includes a TTS exclusion list. This external file contains
information on known problem TTS engines and will result in them being discarded by
Dolphin EasyConverter. At present the exclusion list contains the locked version of the
Travois TTS engine. The exclusion list should only be edited by an administrator with the
assistance of a Dolphin dealer or a member of Dolphin's Product Support staff.
Pronunciation lexicon
The DTB TTS settings and the MP3 TTS settings both share access to Dolphin
EasyConverter's pronunciation lexicon.
From the settings you can select an existing lexicon, create a new lexicon, edit an existing
lexicon, or remove a lexicon.
When selecting the "New" button, the first task is to give the new pronunciation lexicon a
name.
This may correspond to the name of the TTS, the type of material being recorded or
perhaps the client's name. We do recommend that this name is clear and descriptive.
When working with the pronunciation lexicon you will be able to add, modify and remove
words from the lexicon. It is also possible to stipulate whether the characters are case
sensitive and whether they relate to a whole word or just part of a word.
Data stored in other lexicons can also be imported into the current lexicon via the "Import"
button.
Newly created lexicon files are saved as XML files, located in the following location:
On Windows XP:
"C:\Documents and Settings\All Users\Application Data\Dolphin\PronLexicons"
On Windows Vista
"C:\ProgramData\dolphin\PronLexicons"
Text
The options available in this category set the way Dolphin EasyConverter produces text
files.




Text encoding.
This is used to select a custom text encoding; by default this is Western
European. If the images/documents you are working with have character sets
such as Japanese, Chinese, Arabic, Cyrillic then you should select the applicable
text encoding for these character sets.
Insert line breaks.
This is used to insert hard line breaks into the output document. If selected then
you can choose the type of end of line break used.
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Allow character substitution.
This is used to substitute special characters with a text alternative, for example,
substituting the copyright sign with (c) characters.

Braille - Paper
The Braille Paper settings set the size of the Braille paper that will be used to emboss the
document using Dolphin EasyConverter's internal Braille converter.
You can select the default paper size from the available list or enter values for the width
and length.
The value of the paper width and length is measured in Braille cells, allowing for margins
set by the embosser.
Tip: the width of a Braille cell is approximately 1/4 inch (0.64 cm) and the height of a Braille
line is approximately 1/2 inch (1.27 cm).
The margins set the space that is left around the text on Braille pages when using Dolphin
EasyConverter's internal Braille converter.
The margins are measured in Braille cells for width and Braille lines for length. Margins are
usually set to 0 to ensure maximum output per page.
The following settings are available:










Top margin
The distance between the top of the paper and the page header line (if used).
Bottom margin
The distance between the page footer line (if used) and the bottom of the paper.
Left margin
The distance between the left edge of the paper and the first character on a line.
Right margin
The distance from the right edge of the paper to the rightmost character position
on a line.
Header margin
The distance between the header line (if used) and the first line of the text on the
page.
Footer margin
The distance between the bottom line on a page and the footer line (if used).
Binding margin
For binding purposes it may be necessary to add some additional space to the left
or right of a page. This extra space is known as the binding (or gutter) margin.
It is normally added to the left margin.
Alternate binding margin
If this option is selected, the binding margin is alternated between the left and
right sides of the paper, allowing you to emboss double sided more easily. This
setting only has real meaning if your embosser is set to produce double sided
Braille. For odd numbered pages, the binding margin appears on the left side of
the page, for even numbered pages, it will appear on the right.

Braille - General
The general settings for Dolphin EasyConverter's internal Braille converter are as follows:
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Language profile
From the list, select one of the available language profiles to determine how text
is translated into Braille. For example, you can select grade 1 or grade 2 Braille,
or a multilingual mode.
Style profile
From the list, select a style format to use as a template for formatting the Braille.
You may have different templates depending on the style of document you wish to
Braille. For example, a Style Profile to show bullet points or to show page divider
lines.
Show capitals
Select this item if you want the Braille to be in capitalised form. Note that this
setting may have no effect because it can depend on the Braille table selected by
the language profile; many Braille codes are always written with capital signs.
Show hidden text
If you select this item hidden text in your document will appear in the Braille
output. One use for this feature may be to include transcriber notes which only
appear in the Braille.
Automatic hyphenation.
Selecting this option means EasyConverter will attempt to hyphenate long words
that don't fit on the line. This option might be particularly useful for long web
addresses.
Page numbers.
The "Page numbers" list determines whether page numbers are to be part of the
output format. You can choose "Braille only", "Braille + original" or "Braille +
Word". The "Braille + original" option shows both the Braille page number and the
original page number from the source document. The "Braille + Word" option
shows both the Braille page number and the page number from the intermediate
Word document.
Line spacing
This list sets what the line spacing will be in your Braille document.

Braille - Advanced
The following are more advanced settings to control Braille output in Dolphin
EasyConverter's internal Braille converter.







Respect paragraph alignment
If this is selected, the text alignment (left, centered or right aligned) will be shown
in the Braille, if the style profile allows this. If not selected, all text will be left
aligned.
Respect document languages
This should be selected if you are translating a multilingual document, with text in
different languages. If this is not selected, all the text will be converted to Braille
using the default language.
Respect bold text
If this item is selected then bold text will be emphasized in the Braille, otherwise
the bold attribute will be ignored.
Respect italic text.
If this item is selected then italic text will be emphasized in the Braille, otherwise
the italic attribute will be ignored.
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Respect underlined text
If this item is selected then underlined text will be emphasized in the Braille,
otherwise the underline attribute will be ignored.

The emphasis marks used to show bold, italic and underlining are defined by the Braille
tables. Some Braille codes combine bold, italic and underline into a single "emphasized"
attribute. These three user settings determine whether the attributes in the text have any
effect or not.














Respect document hard line breaks
If this item is selected then a hard line break in the document will also mean a
new line will be taken in the Braille document. This setting can be useful for
poetry. If this setting is not selected then hard line breaks will be ignored and
Braille will continue on the same line.
Respect document hard page breaks
If this setting is selected then section and page breaks in your original document
will cause equivalent page breaks in the Braille document. With this item not
selected, page breaks will be ignored and the Braille will continue on the next line.
Respect blank lines
If this setting is selected then blank lines (empty paragraphs) in the document will
be respected and appear as blank lines in the Braille. If this setting is unselected
then empty paragraphs will be ignored and Braille will continue on the next line.
This prevents excess blank space being output.
Use computer code for network paths and Internet addresses
Some Braille codes use a special computer code for identifying certain things
such as web and email addresses. With this setting selected, Dolphin
EasyConverter attempts to detect these and will Braille them in the computer
Braille code as defined by the language profile.
Method for untranslatable characters
This list lets you select a method for handling characters that could not be dealt
with. Such characters may include symbols, foreign characters and other
Unicode values not in the Braille translation table. There are three choices:
Ignore the character, replace it with a default substitute (two full Braille cells - two
for-signs) or to render the character number (Unicode).
Method for handling images
This list sets how images should be handled during the conversion process.
There are three ways: ignore them totally, render them if they have ALT text, or
always render them (even if they don't have ALT text). Normally, the word
"Image" is placed before an image to show that a picture was in the original text.
Method for handling tables
This list sets how tables should be handled during the conversion process. There
are two ways: ignore them totally or render them in paragraph form. In
paragraph form, each row of the table is Brailled as a paragraph with each column
separated by a semicolon; empty cells are represented by a dash.

Braille - Embosser
Dolphin EasyConverter's internal Braille converter will use the following Braille embosser
settings.

Page 45

Once these are set up it is unlikely you will want to change them unless you use a new
embosser.








Name of embosser
Select the Braille embosser that Dolphin EasyConverter should use to print your
Braille documents. The list available will correspond to the list of printers and
embossers installed on your system. We would recommend, if you have not set
up a suitable embosser, that you install and select a Windows Generic/Text only
printer.
Use Line Feeds
Some embossers automatically add a line feed (LF) whenever a carriage return
character (CR) is sent. Most do not. Select this item as appropriate for your
embosser. Generally, you will select this option. The easiest way to know if this
setting is wrong will be because you get either a single overprinted line, or double
spaced output when you didn't expect it.
Use Formfeeds
Most embossers can interpret the formfeed character to move to the top of a new
page, some cannot. Set this checkbox as appropriate for your embosser.
Generally, this option will be selected.
Embosser character set
From the list, choose which character set to use when embossing. Make sure
the selected character set matches the one selected on your embosser.

Large Print Fonts
You can customize how the font is used when Large Print documents are created.






Point size.
The point size option sets the text size to be used for "Normal" text.
Minimum and Maximum point size.
This setting states the boundaries on how much the font can alter within the
output document.
Use document fonts.
This setting lets you choose to keep the font types used in the document or set
another one.
Use document colors.
This setting lets you choose to keep the colors used in the document or set
another one.
Use document styles.
This setting lets you choose to keep the style used in the document or edit it.

Large Print Layout
You can control how the large print document is laid out through the layout settings.


Use full printable area.
If this is selected then the whole of the printable area of the output document is
used.
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Remove blank lines.
This is used to remove blank lines from the output document. The primary
purpose of this is where the original input document has groups of multiple blank
lines and you do not wish to have these in the output document.
Remove white space.
This is used to remove unnecessary spacing in the output document. This uses
Word's AutoFormat feature to perform this task.
Remove left indent.
If the original input document has left indents and you do not wish these to appear
in the output document then use this option.
For objects that won't fit after scaling.
This gives you various options on how to deal with objects that will not fit correctly
in the output document after scaling to fit has been performed.
Wrap shapes inline.
In Microsoft Word, shapes can be floating on top of the document or be inline
(positioned directly in the text of the document). This item forces all shapes to be
inline. This helps shapes to maintain their correct position in the document after
enlarging as floating shapes can often end up in odd locations because they can
be positioned relative to other objects.
Line spacing.
This option will let you stipulate the spacing between lines in the output document.
Paragraph spacing.
Paragraph spacing can be preserved, removed or scaled relative to the increased
text size.

Large Print Page
The appearance and position of page numbers are defined in this category.





Page numbers.
The "Page numbers" list determines whether page numbers are to be part of the
output format. You can choose "No page numbers", "Original page numbers" or
"Word page numbers". The "Original page numbers" option retains the source
page references. The "Word page numbers" option takes the page numbers from
the intermediate Word document that is part of the conversion process.
Layout.
You can specify where page numbers should be displayed e.g. bottom right,
bottom left etc. from the "Layout" list.
Numbering scheme.
How the page numbers are displayed can also be controlled. A list box provides
access to the choices available.

CD/DVD
The options in this category define how the output data will be written to your CD/DVD
drive.
Options are:



Drive
Write mode
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Write speed
Buffer under run

Copy to
Output settings set the options available for the different output formats.
There are also a number of general output settings. These apply to all irrespective of the
output media selected.



Default copy to folder: Where, by default, a copy of your conversion will be saved
to. Change the location by using the 'Browse' button.
Printers: The "Printer" setting sets the location for the "Send to printer" media
option. This is the default printer for all output formats with the exception of
Braille.

Miscellaneous
In this category you can set the "Miscellaneous" settings available in EasyConverter.
You can set:




Voice for help system.
You can select the voice to read aloud the EasyConverter help by choosing a
voice from this list. This list shows all the compatible TTS Voices available on
your computer.
Play sound on conversion complete, fail and abort.
You will hear an audible chime when a conversion is complete, has failed or is
aborted by selecting this check box.

EasyReader Express
In this category you add and save your "EasyReader Express" account details.
EasyReader Express is a subscription service that enables you to add EasyReader
Express to your DTB output. Adding EasyReader Express will ensure your clients can play
the DTB content on their PC irrespective on whether they have a DAISY Digital Talking
Book software or hardware player.
Visit the Dolphin web site to learn more about this service.
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Microsoft Word tips
Microsoft Word is the intermediate document editor. How the document is structured can
influence how the resulting output appears. It is therefore very useful to know some of the
basic options available in Microsoft Word that control a document's layout.
Note: The instructions provided are based on Microsoft Office Word 2007. The steps to
follow may differ slightly if using an alternative version of Microsoft Word.

Summary list
Below is a list of "good practice" tips to adhere to when working in Microsoft Word
documents. Help in applying these good practices is explained later in this chapter.











Use styles instead of manual formatting. This includes the proper use of styles to
create headings, line spacing, paragraph spacing and numbered and bulleted
lists.
Do not misuse symbols. For example, don't use a lower case x in place of the
multiplication sign, or an l for a digit 1 or a capital O for the digit zero. Do not use
quotes to mean feet or minutes, or apostrophe to mean inches or seconds, write
the words.
Use ALT text for inline pictures.
Do not press ENTER lots of times to get to the top of a new page. If you want to
start a new page, use a proper page break.
Use field codes for things like page references and section references. If you
use field codes, Dolphin EasyConverter will be able to correctly render the page
number during conversion.
Use double quotes for quotation marks. Single quotes are best avoided unless
you need them. This is because often the closing single quote is misused
interchangeably with the apostrophe.
Mark up your document with the correct language information. This is particularly
important if you are writing a multilingual document that you plan to convert to
Braille.
Make sure that your page header and footer text is concise. Only one line is
allocated for page headers and footers in Braille and this line is shared with the
page numbers, so it is important to make sure that the text will fit.
Make sure that all fields, especially tables of contents, are updated before you
pass your document to Dolphin EasyConverter.

Applying a heading style
Applying a heading style means assigning a specific inbuilt Microsoft Word style to the
current paragraph. How this heading style appears can be defined by you but it must be
the inbuilt heading style that is used. It cannot simply be the customizing of normal text
with different font styles.
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You can apply a heading style to a paragraph in a number of ways: through the "Styles"
section of the "Home" tab in the Office ribbon or by using the Microsoft Word hot keys.
The Microsoft Word hot keys are:

To apply the Heading 1 style:

Press: CONTROL + ALT + 1.
To apply the Heading 2 style:

Press: CONTROL + ALT + 2.
To apply the Heading 3 style:

Press CONTROL + ALT + 3.

Applying page breaks
With some digital talking book (DTB) players it is possible to navigate the book by pages
as well as navigating by headings.
When creating a DTB within Microsoft Word, Dolphin EasyConverter will use Microsoft
Word's page numbering as defined for the current document. This can be seen on the
status bar when in Print Layout view.
When a page is filled with text or graphics, Microsoft Word inserts an automatic (soft) page
break. You can also force a page break at a specific location by inserting a manual (hard)
page break.
If you work on documents of more than several pages in length, and you insert manual
page breaks, you might have to frequently rebreak pages as you edit the document.
Instead, you might want to set pagination options to control where Microsoft Word
positions automatic page breaks.
Inserting a page break
To insert a manual page break go to the "Insert" tab and then select "Page break". This
can also be done by pressing CONTROL + ENTER.
A more structured approach is to adjust Microsoft Word's pagination settings so that page
breaks occur automatically as required. This ensures a more consistent layout to the
document.
To view and adjust Microsoft Word's pagination options, select the paragraph(s) to adjust,
open the "Page Layout" tab and select Paragraph. In the Paragraph dialog open the
"Lines and page breaks" property sheet.


Widow/orphan control
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A widow is the last line of a paragraph printed by itself at the top of a page. An
orphan is the first line of a paragraph printed by itself at the bottom of a page.
Selecting this option (which is on by default) ensures a page break will not result
in a widow or orphan appearing in the document.


Keep with next.
Selecting this check box will mean your selected paragraphs cannot be
separated by a page break.



Keep lines together.
Selecting this check box will mean your selected lines in a paragraph cannot be
separated by a page break.



Page break before.
Selecting this check box will mean your selected paragraph will always have a
page break inserted before it.

Prevent a table being split over two pages
As with paragraphs, it is also possible to prevent rows within a table being split over two
pages.
To do this position the focus on the row or rows that are not to be separated, press
MOUSE BUTTON RIGHT to open the Table menu and select Table Properties. Select
the Row tab and unselect the Allow row to break across pages check box.

Applying alt text to images
An image inserted into a document can contain an alternative text description. Dolphin
EasyConverter will extract this text along with the image when creating a suitable format,
for example, the digital talking book (DTB) or MP3 recording.
To add Alt text:
1. Select your image.
2. RIGHT MOUSE click on the image and select "Size" from the menu.
3. Select the "Alt Text" tab.
4. Insert your Alt text and select "Close".

Applying language settings in multilingual documents
Dolphin EasyConverter's internal Braille converter can support multilingual documents.
This, of course, does depend on the availability and selection of an appropriate translation
table. To view the available tables in Dolphin EasyConverter, open the "Settings" dialog
and select the "Braille - General" option. Multilingual tables are generally identified by the
word "multi" or "multilingual" in the name.
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In order for a multilingual document to be converted correctly into Braille the text in the
intermediate document must be marked up in the language. Dolphin EasyConverter uses
the language markup to determine the translation table to use.
How to set a language:
1. Select the text to markup.
2. Select the "Review" tab.
3. Select "Set Language" and then choose the desired language.
4. Select "Okay".
Note: in Dolphin EasyConverter "Settings" dialog, "Braille - Advanced" options, make sure
the checkbox "Respect document languages" item is selected.

Special Braille codes
There are certain codes which have special meaning to Dolphin EasyConverter's Braille
converter. You can use these codes for special Braille symbols as necessary in your
document.
Each of the special codes is introduced by the tilde character (~). This means that in
order to type a tilde character itself, you need to type tilde twice.
The special codes are as follows:
~=

A letter sign

~^

A capital sign

~^^

Double capital sign

~^^^

Triple capital sign

~#^

Capital terminator sign

~_

An underline (emphasis) sign

~__

Double underline (emphasis) sign

~#_

Underline (emphasis) terminator sign

~*

A bold sign

~**

Double bold sign

~#*

Bold terminator sign

~/

An italic sign

~//

Double italics sign

~#/

Italic terminator sign

~\

Break translation code

~[

Begin transcriber note

~]

End transcriber note

~~

A tilde itself

~“

Enter computer code sign
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~”

Exit computer code sign

Some of these codes may also exist without the initial tilde for backwards compatibility.
For example ^ can be used for a capital sign.
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Product support and licensing
In this chapter you will find information on the various product support resources available
for Dolphin EasyConverter and, provided as a reference, Dolphin EasyConverter's
software license agreement.

Getting support
Support for Dolphin EasyConverter can be obtained from a number of sources.
Your Dolphin Dealer: Product support will be provided by the dealer that you purchased the
product through, therefore in the first instance please contact your local dealer for product
support.
Web-based Support: Visit www.yourdolphin.com to find a range of resources that may prove
useful, especially outside working hours.
They include:







An on-line Knowledge Base with search capabilities.
Product information.
Links to mailing lists where clients can share articles, questions, tips and tricks.
Product news and services.
Information about available updates and upgrades.
Occasionally Downloadable enhancements.

Contacting Dolphin
In order to receive product support from Dolphin's Help Desk, you will need to be a
registered user of the product. Registered users receive full product support for the lifetime
of the product.
Before calling the help desk please make sure you know your product serial number.
This is displayed in the "About" dialog in Dolphin EasyConverter.
Contact details
In the United Kingdom:
Dolphin Computer Access Ltd.
Technology House
Blackpole Estate, West
Worcester WR3 8TJ
United Kingdom
Sales:
Email: info@dolphinuk.co.uk
Tel: +44 (0) 1905 754 577
Tel (local rate): 0845 130 5353
Fax: +44 (0)1905 754559
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Help desk:
Email: support@dolphinuk.co.uk
Tel: +44 (0)1905 754765
Tel (local rate): 0845 130 5454
Fax: +44 (0)1905 754559
Telephone support in the UK is normally available on standard working days from 9am to
5:30pm, Monday to Friday. E-mail and Fax messages sent outside these hours may not be
responded to until the next working day.

Help for screen reader users
Dolphin EasyConverter includes:



A JAWS Script file.
A SuperNova Map file.

You should import the relevant file if you use one of these screen readers or magnifiers.
Note that the SuperNova Map file also supports Dolphin Hal, Lunar and LunarPlus.
You can find these files in the "ScreenReaders" folder. The "ScreenReaders" folder is
found in the EasyConverter installation folder.

End User License Agreement
This End User License Agreement ‘EULA’ is a legal agreement between you, the end user
("You") and Dolphin Computer Access Ltd ("Dolphin").
Please read this EULA carefully. If you do not agree to these terms, you must return the
full product with proof of purchase to your dealer within 30 days for a full refund.
WARNING - ONCE A PRODUCT HAS BEEN ACTIVATED A REFUND IS NOT
AVAILABLE.
1. Ownership.
This Product includes computer software ("Software"), associated media, Braille, audio CD
or audio cassette or print materials, any electronic documentation and all rights to the
product are owned by Dolphin. The Product is licensed to you and not sold. The Product is
protected by copyright laws, international copyright treaties and intellectual property laws.
2. License.
2a. Desktop/Laptop Version - This Product is licensed for a single user only. You may
install and use it only on computers that you operate and own. If a network or multi-user
site license has been purchased, the number of concurrent users is restricted to that
purchased. Additional licenses must be purchased for any additional users.
3. Restrictions.
You may not copy the Software, except for one copy solely for backup or archival
purposes providing you keep this copy in your possession. You may not modify, translate,
decompile, disassemble, or otherwise reverse engineer the Software. You may not loan,
rent, lease or sub-license the Software or any copy to others for any purpose.
4. Transfer.
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You may transfer the Product to another party on a permanent basis providing the
recipient agrees to the terms of this EULA and you retain no copies of the Software.
5. Termination.
You may terminate this EULA at any time. If this EULA is terminated you must destroy the
Product together with all copies of the Software in any form.
6. Export Rules.
If purchased in the United States, this Product or any of its components shall not be
exported or re-exported in violation of any export provisions of the United States or any
other applicable legislation.
7. General.
7a. COPYING RESTRICTIONS: End-User may copy the Software, in whole or in part, only
for backup and archival purposes. No more than two (2) copies may be in existence at any
one time. Each copy shall include in readable format any and all proprietary and copyright
notices contained on the original.
7b. PREVENTION OF UNAUTHORIZED USE: End-User shall not knowingly permit
anyone to use any portion of the Software, (a) for purpose of deriving its source code, and
(b) for purposes other than as authorized in the Software License Agreement.
7c. THIRD PARTY SOFTWARE: The Software is protected by Copyright and other
proprietary rights of Dolphin and/or third party software vendors. The Product includes
software licensed to Dolphin by third-party vendors, End-User may be held directly
responsible by such vendor for acts relating to the Product that are not authorized by this
Agreement.
7d. If you break the terms of this EULA, Dolphin may terminate this EULA and reserves
the right to take action to prevent or restrict your use of the Product.
7e. If any part of the EULA is found to be void and unenforceable, it will not affect the
validity of the remainder of the EULA, which shall remain valid and enforceable according
to its terms.
8. Distribution of digital and audio content.
8a. You are permitted to distribute digital and audio content created using this product
providing the correct copyright has been obtained
8b. You are permitted to distribute commercial digital and audio content created using this
product providing the correct license has been obtained from Dolphin.
8c. If you use a Text-To-Speech (TTS) solution other than that provided with this product,
you must ensure you obtain the rights to create and distribute the content from the owner
of the TTS
9. Distribution of Dolphin EasyReader Express.
If you are using Dolphin EasyReader Express in this Software the Dolphin EasyReader
Express License Agreement (Appendix A) applies to you as a part of the License.
10. Unregistered demonstration version.
The unregistered demonstration version of the Software may not be bundled or distributed
with any other package without written permission of Dolphin.
11. Fraunhofer technology
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The MPEG Layer-3 audio coding technology is licensed from Fraunhofer IIS and
Thompson.
12. Nuance SDK
The Nuance SDK© is a registered trademark of Nuance.
Copyright (c) 2014 Dolphin Oceanic Limited and Dolphin Computer Access Limited. All
rights reserved worldwide.
Notice
Dolphin EasyConverter, Dolphin EasyReader Express and Dolphin EasyScan are
trademarks of Dolphin Computer Access Ltd. Windows, Windows NT, Windows ME,
Windows 2000 and Windows XP are registered trademarks of Microsoft Corporation. All
other trademarks are the property of their respective owners.
Disclaimer
Dolphin takes all reasonable steps to ensure that the software distributed is free from
defects and subject to being notified of any defects within 7 days of your receipt of the
software, it will replace such software at no charge.
N.B.
* You should save your work and make regular backups, particularly before installing
new software or hardware.
* Due to the many possible hardware configurations and inherently complex nature of
software, errors do occur.

APPENDIX A - DOLPHIN EASYREADER EXPRESS
License AGREEMENT
DOLPHIN COMPUTER ACCESS GROUP the “Owner”
PLEASE READ THIS CAREFULLY BEFORE YOU USE THE SOFTWARE
IMPORTANT

-

READ CAREFULLY

BY CLICKING THE 'NEXT' BUTTON TO THE SOFTWARE PRODUCT AT THE END OF
THIS License YOU AGREE TO BE BOUND BY THE TERMS OF THIS License
AGREEMENT
YOUR RIGHT TO USE THIS SOFTWARE PRODUCT IS SUBJECT TO THE TERMS SET
OUT IN THIS License AGREEMENT. USING THIS SOFTWARE PRODUCT INDICATES
YOUR ACCEPTANCE OF THESE TERMS. IF YOU DO NOT ACCEPT OR
UNDERSTAND THEM, YOU MAY NOT USE IT.
1. Grant of license
Under copyright law you are not permitted to use and distribute the software product ('the
Software') or use the user manuals and other documentation ('the Documentation')
supplied to you without the permission of Dolphin Computer Access Group ('the Owner').
In consideration of your agreement to the terms of this Agreement the Owner grants you a
non-exclusive right ('the License') to use and distribute the Software and the
Documentation as permitted by this Agreement. All references to the Software mean the
object code only of the program(s) comprising the Software (but include all upgrades and
updates provided by the Owner).
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YOU ARE PERMITTED TO:
1.1 use the Software and Documentation packaged to and distributed together with digital
content you have secured the rights to distribute. Digital content refers to any information
that is published or distributed in a digital form, including text, audio, images and video;
1.2 transfer your content with the Software included;
1.3 if you are a service provider or a production company creating content on behalf of a
third party, use the Software and Documentation packaged to and distributed together with
digital content you have secured the rights to distribute for one third party only. Additional
Licenses must be secured for each third party thereafter.
YOU MAY NOT NOR PERMIT OTHERS TO:
1.4 use the Software except as permitted by this Agreement;
1.5 transfer your License to another organisation or person without the permission of the
Owner;
1.6 copy the Documentation in any manner;
1.7 alter, adapt, merge, modify or translate the Software or the Documentation in any way
for any purpose, including, without limitation, for error correction;
1.8 reverse-engineer, disassemble or decompile the Software except that you may
decompile the Software only to the extent permissible by law where this is indispensable to
obtain the information necessary to achieve the interoperability of an independently
created program with the Software or with another program and such information is not
readily available from the Owner or elsewhere;
1.9 remove, change or obscure any product identification or notices of proprietary rights
and restrictions on or in the Software and Documentation.
2. Term and termination
2.1 You must have a valid subscription with the Owner in order to use and distribute the
Software. You cannot continue to distribute content packaged with the Software once the
subscription has expired.
2.2 Your License to use the Software and Documentation will terminate automatically if
you fail to comply with any term of this Agreement or your subscription. The License will
also terminate without further action or notice by the Owner if you become bankrupt, go
into liquidation, suffer or make any winding up petition, make an arrangement with your
creditors, have an administrator, administrative receiver or receiver appointed or suffer or
file any similar action in consequence of debt.
2.3 The Owner will withdraw your License if content that give general offence or that cause
general offence are distributed.
2.4 Upon termination of the License for any reason you will destroy the Software and
Documentation together with all copies in any form, including copies on your hard and
back-up disks or undistributed copies in your stock. Any use of any copies of the Software
or Documentation after termination of the License is unlawful.
3. Liability
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Unless otherwise provided for by statute the Owners entire liability and your exclusive
remedy under this License Agreement is the owners option to refund the price paid for
the Software from you to the Owner and terminate the License and then only in the event
that the Software does not perform as described in the Documentation and notification is
given by you to the Owner within 30 days of receipt by the customer of the Software.
4. Exclusion of warranties
Save for any statutory provisions which may apply the Owner and its suppliers make and
you receive no warranties, conditions or representations, express or implied, statutory or
otherwise, and without limitation the implied terms of satisfactory quality and fitness for a
particular purpose are excluded. The Owner does not warrant that the operation of the
Software will be error free or uninterrupted. It is your responsibility to ensure that the
Software is suitable for your needs and the entire risk as to the performance and results of
the Software and Documentation is assumed by you.
5. Disclaimer
5.1 In no event will either the Owner or its suppliers be liable for any direct, consequential,
incidental, or special damage or loss of any kind (including without limitation loss of profits,
loss of contracts, business interruptions, loss of or corruption to data) however caused and
whether arising under contract, tort, including negligence or otherwise.
5.2 If any exclusion, disclaimer or other provision contained in this Agreement is held
invalid for any reason and the Owner becomes liable for loss or damage that could
otherwise be limited, such liability, whether in contract, negligence or otherwise, will not
exceed the amount actually paid by you for the Software.
5.3 The Owner does not exclude or limit liability for
5.3.1 death or personal injury resulting from an act or negligence of the Owner [or
5.3.2 damage caused by a defect in the Software within the meaning of the Consumer
Protection Act 1987 Part ].
5.4 You acknowledge that the allocation of risk in this Agreement reflects the price paid by
you to the Owner for the current subscription and also the fact that it is not within the
Owner's control how and for what purposes the Software is used by you.
5.5 It is your responsibility to ensure that you have all necessary consents or licenses in
relation to any material or data or other programs you distribute and/or use in conjunction
with the Software and obey any and all restrictions relating to the material such as, by
example, but not limited to the display of copyright notices.
5.6 It is your responsibility to publish intellectual property and copyright information
protection notices for the content in the material packaged with the Software.
5.7 It is your responsibility to ensure that the packaged combination of the content and the
Software meets your own and your end users expectations and requirements before it is
duplicated and distributed.
6. Copyright
6.1 All right title and interest in and to the Software and the Documentation belongs to the
Owner
6.2 All right title and interest in and to the content played using the Software belongs to
and is governed under the terms and conditions expressed by the publishers of that
content. It is your responsibility to fulfill requirements stipulated by applicable copyright
laws for the content distributed with the Software.
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6.3 All right and license to use or distribute the recorded output from any 3rd party
synthesizer that is not distributed as part of the Software as a whole must be obtained by
you from the appropriate person and is your responsibility.
7. Updates
7.1 The Owner may update or upgrade the Software but shall not be obliged to furnish
such updates or upgrades to you unless the subscription fee has been paid
8. Support
8.1 The Owner will provide email support to you only for the Software at the following
address support@dolphinuk.co.uk
8.2 It is your responsibility to provide support to your end-users. The Owner do not offer
support to your end-users
9. General
9.1 This Agreement is the entire agreement between you and the Owner and supersedes
any other oral or written communications, agreements or representations with respect to
the Software and Documentation.
9.2 Nothing in this Agreement will affect the statutory rights of a consumer in 'consumer
transactions' under any applicable statute.
9.3 If any part of this Agreement is held by a court of competent jurisdiction to be
unenforceable the validity of the remainder of the Agreement will not be affected.
9.4 This Agreement is governed by the laws of England and Wales.
9.5 Should you have any questions concerning this Agreement please contact (Dolphin
Computer Access Limited, Technology House, Blackpole Estate West, Worcester, WR3
8TJ, United Kingdom.).
9.6 The provisions of the Contracts (Rights of Third Parties) Act 1999 shall not apply to
this Agreement.
9.7 The Owner reserves the right to change the content of this License Agreement from
time to time.
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